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This tutorial demonstrates how to use Collecting Hot Tickets in Asanti.  

Download the Asanti Sample Files via the Asanti Client (Help > Asanti Online > Download Sample Files). 
 
Collecting Hot Tickets are Hot Tickets that collect a number of files before it splits off a job ticket. Collecting Hot Tickets require you to manually 
define a production plan. Wide Format Job Tickets and hot Tickets will automatically define this production plan.   
 

1. Basic Collecting Hot Ticket 

Create a Wide Format job and Wide Format Ticket Template to be used by the Collecting Hot Ticket 
1. File > New Wide Format Job. 
2. Select your output device for instance an Anapurna and set sheet size to 1200x750 mm. 
3. Select a Production Quality CPM, in the Finishing inspector select "iCut Corner Marks, between 10". 
4. Submit the job, name it "For template creation only" and select "Make and send to printer". 
5. Context-click the "For template creation only" job and select Save As Template. 
6. Save the Template in any category and name it "Anapurna 1200x750 production quality". 

Create a Collecting Hot Ticket 
1. Click the Hot Tickets link at the bottom of the client window to 

navigate to the Hot Tickets window. 
2. In the Hot Tickets window, select File > New from Templates. 
3. Select the Hot Tickets tab, select the “Blank Collecting Hot 

Ticket” in the Blank Category. 
4. Type “Basic Collecting Hot Ticket” in the Hot Ticket name field 

and click Open.  

• The Production Plan editor is opened and not the Layout 
editor. 

 

Workflow Automation: Collecting Hot Tickets 
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5. Drag the HotFolder Task Processor to the Plan. 
 
 
 
 
 

6. Click the next tab in the Plan Editor and drag the Normalize Task 
Processor also to the plan. Place it next to the HotFolder so that it 
connects and shows a green vertical line between the two Task 
Processors. 
 
 
 

7. Unlock the Normalize Task Processor settings by clicking the 
padlock and select the PDFProcessing Tab. 
 
 
 

8. Set Convert all PANTONE names to Coated. 
 
 
 
 
 

9. Click the third tab in the Plan Editor and drag the Collect Task 
Processor to the plan after the Normalizer. 
 

10. Unlock the Collect Task Processor settings by clicking the padlock 
and select the "Anapurna 1200x750 production quality" Wide 
Format Ticket Template that we created earlier. 
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11. Double-click the flow name "Initial" to rename it and type 
"Anapurna-1200x750" as flow name. 
 
 

12. Select the Collect Task Processor in the Production Plan to verify 
the other settings. 
 
 
 

13. Notice that Zone A which is defined in the Coverage zones 
section is set to 60% (for sheet media) and that Zone C is set to 
80%. 
 
 

14. Click the Submit button (left top) to activate your Collecting Hot 
Ticket. 
 
 

15. Verify all names/components of your first Collecting Hot Ticket. 

• Collecting Hot Ticket name 

• Collecting Hot Ticket Flow name 

• Ticket Template name used on Collect Task Processor settings: 
this name will also be used as job name (see later)  
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Using the Collecting Hot Ticket (abbreviated to CHT) 
1. Context-Click the CHT and select Upload Document.  
2. Upload the "pancakes.pdf" file from the SampleFiles. 

• The CHT flow identifier will be green while processing the file. 

• After processing the flow identifier will be white and the file will be present in the queue of the CHT. 

• The file dimensions (700 x 700 mm) and copy count (# 1) are shown. 

• When the file fits on the 1200x750 sheet (as defined in the Ticket Template) then the "On" column will show the flow name. 

• The pancakes file actually only covers 56% of the sheet. 

• This coverage is lower as the minimum required sheet coverage as defined in the Collect parameters (60%), therefore the queue status 
bar color is pink. 

 

 

 

 

3. Add the "Circle of Asanti.pdf" file to the CHT. 

• The file is also added to the queue and the sheet coverage increases to 68%. 

• The queue status bar now becomes orange because this is higher as the 60% threshold that was defined in the Collect settings. 

 

 

 

 

4. Finally add the "Asanti Box.pdf" and "Asanti Sticker 01.pdf" files to the CHT. 

• The Sheet will now be covered for more than 80% which was the upper threshold and therefore the CHT triggers the creation of a Job. 

• All products will be removed from the CHT Queue. 
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5. Open the jobs List and select the job "Anapurna 1200x750 
production quality [TIME]". 

• The name of the created job is “[Ticket Template] [TIME]”. 

• The job is immediately printed because the "Anapurna 
1200x7500 production quality" Ticket Template was made 
based on a "Make and send to printer" job. 

• You can open the job in the Layout Editor to check that it has 
the same settings as defined in the Ticket Template. 

 

CHT which will create jobs in Hold 
1. Edit the "For template creation only" job. 
2. Submit it again but this time select “Make and Hold”. 
3. Context-Click the job and select Save As Template. 
4. Save the Template in any category and name it "Anapurna 1200x750 production quality hold". 
5. Duplicate the "Basic Collecting Hot Ticket". 

 
 
 

6. Change the name to “Basic Collecting Hot Ticket - Hold”. 
7. Select the Plan tab and change the Wide Format Ticket Template 

to “Anapurna 1200x750 production quality hold".  
8. Click the Submit button to create the new CHT. 
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9. Context-click “Basic Collecting Hot Ticket – Hold” and select “Enable Inputs” to make your CHT ready 

for accepting input documents. 
 
 

10. Upload the same documents as earlier to Basic Collecting Hot Ticket - Hold: "Asanti Box.pdf", 
"Asanti-sticker-01.pdf", "Circle of Asanti.pdf" and "pancakes.pdf". 

• A new job is created but now it will be put in hold after rendering so that you can still verify the 
results before sending it to the printer. 

• Jobs created by CHT are regular Wide Format jobs and can therefore still be edited and adjusted. 
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CHT which will create also cut files 
1. Edit again the "For template creation only" job. 
2. Select a Cutter in the Finishing inspector for instance Zünd.  
3. Submit the job with “Make and Hold” workflow. 
4. Context-Click the job and select Save As Template. 
5. Save the Template in any category and name it "Anapurna 1200x750 production quality cut and hold". 
6. Duplicate the "Basic Collecting Hot Ticket". 
7. Change the name to “Basic Collecting Hot Ticket - Cut and Hold”. 
8. Select the Plan tab and change the Wide Format Ticket Template to “Anapurna 1200x750 production 

quality cut and hold".  
9. Click the Submit button to create the new CHT. 
10. Context-click “Basic Collecting Hot Ticket – Cut and Hold” and select “Enable Inputs” to make your CHT ready for accepting input 

documents. 
11. Upload again the same documents as earlier to Basic Collecting Hot Ticket - Cut and Hold: "Asanti Box.pdf", "Asanti-sticker-01.pdf", 

"Circle of Asanti.pdf" and "pancakes.pdf". 

• A new job is created but now a cut file 
will also be generated. 

• Due to the selection of the Zünd cutter 
you might also notice that Zünd cut 
marks are automatically added to the 
Sheet. 
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2. Manually submit job from Collecting Hot Tickets 

Flushing a Collecting Hot Ticket Sheet 
1. Upload the following files to the Basic Collecting Hot Ticket – 

Hold: “ASANTI Visual 390x250.pdf”, “Asanti-sticker-01.pdf”, 
“Circle of Asanti.pdf”, “Disco_ball_600x400.pdf”, “Flowers 
150x50mm.pdf” and “Huidtinten.jpg”. 

• The sheet is not sufficiently covered to be automatically submit 
as indicated by the queue status bar. 

 

2. Add the file “Asanti CMS demo page V5.pdf”. 

• Adding this file has caused the creation of a second sheet that 
is being filled by our Collecting Hot Ticket. 

 

3. Click the Flush button after the status bar of the first sheet. 

• This will trigger the creation of our job which only contains a 
partially (63%) covered sheet. 

• All the files that were placed on the first sheet are removed 
from Collecting Hot Ticket queue. 

• Only 1 file is left in the queue which is currently placed on the 
remaining sheet. 
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Flushing the Sheet which contains a specific file 
1. Add the following files to the Basic Collecting Hot Ticket – Hold: 

“Agfa Flag.pdf“, “Agfa_logo_color.jpg”, “Asanti Box.pdf”, “Asanti 
CMS demo page V5.pdf”, “ASANTI Visual 390x250.pdf”, “Asanti-
sticker-01”.pdf, “Castle-4-EPS.jpg”, “CHIMAY BLEU.jpg”, 
“CHIMAY.jpg”, “Cleaning Product CMYKWhite.pdf”, “Do Not 
Disturb (CMYK).pdf” and “Fish_Label_Layers.pdf”. 

• You should have in total 13 files as indicated also in the 
Collecting Hot Ticket queue.  

• As you can see again a 2nd sheet has been created. 

2. Select the first file from the Collecting Hot Ticket queue. 

• A thumbnail of the selected file is shown in the Info pane. 

• The sheet on which the file is located is indicated with a dark 
blue frame. 

3. Scroll through the list of the other files in the Collecting Hot 
Ticket queue to see on which sheet they are located. 

• Asanti Box is the only file located on the second sheet. 

• We will discuss later the layout algorithm which causes this 
file to be located on the second sheet. 

4. Type “clean” in the filter at the top of the Collecting Hot Ticket 
queue to find a specific file. 

5. Context-click this file and select “Flush Image”. 

• This will flush the sheet on which this image is present (this is 
again the first sheet as indicated by the dark blue frame). 

6. Click the x button after the file filter to see the complete 
Collecting Hot Ticket queue again. 

• Only the Asanti Box file is shown in the Collecting Hot Ticket 
queue since all other files were also located on the first sheet 
that we just flushed.  
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3. Collecting Hot Tickets and file copy counts 

Detect copy count in filenames of input documents 
1. Duplicate the Basic Collecting Hot Ticket – Hold. 
2. Change the name to “CopyCount Collecting Hot Ticket - Hold”. 
3. Select the Plan tab, select the HotFolder, click the padlock to 

change the settings; add “_<COPYCOUNT>” to the Filename 
template.  

4. Click the Submit button to create the new Collecting Hot Ticket. 
5. Context-click “CopyCount Collecting Hot Ticket – Hold” and 

select “Enable Inputs” to make your Collecting Hot Ticket ready 
for accepting input documents. 

Adjust filenames with copy count info 
1. Open Windows Explorer and browse to your Asanti SampleFiles. 
2. Create a subfolder in the Asanti SampleFiles directory and name this 

CopyCount. 
3. Copy the Asanti SampleFiles “CHIMAY.jpg” and “Flowers 

150x50mm.pdf” to this folder. 
4. Rename the files to “CHIMAY_3.jpg” and “Flowers 150x50mm_4.pdf”. 

Upload files to the CopyCount Collecting Hot Ticket 
1. Select the CopyCount Collecting Hot ticket – Hold. 
2. Open Windows Explorer and open the CopyCount folder. 
3. Drag and drop the two files in the file Queue of on our Collecting 

Hot Ticket. 
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4. Upload also a regular file for instance “Woman with grapefruit 493x740.jpg”. 

• The files copy count is shown in the Collecting Hot Ticket queue (# column). 

 

 

5. Click the Flush Sheet button to create the job. 

• Our job shows that the CHIMAY file is placed 3 times, the Flowers file is placed 4 times and 
the Woman with grapefruit file is only placed once as was defined by the files copy count. 

 

 

 

Export File List 
1. Context-click the split of job and select Export > File List. 

 
 
 

2. Save the text file somewhere on your system and open it with notepad or wordpad. 

• The file shows the filenames of the products that are placed on the sheet. 

• The first number after the file/product indicates the page number (so this will 
only be different as 1 when uploading multi-page pdf documents). 

• The second number indicates the copycount. 

 

Manually removing files 
1. Select the Basic Collecting Hot Ticket – Hold. 
2. Context-click the "Asanti Box.pdf" file in the Collecting Hot Ticket file queue and select Delete Image. 

• The file is now removed from the Collecting Hot Ticket queue. 

• Therefore it is also removed from the sheet on which it was located.  
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4. Collecting Hot Tickets and Job Parameters 

Create new Ticket Template 
1. Edit the “For template creation only” job and add the "pancakes.pdf" file to the Product list 

and place it on the sheet. 
2. Select the Mark Sets inspector and select the "Image Info" Image mark set. 
3. Select also the "Print Info" Sheet mark set. 

• The "Zünd" Sheet mark is normally conditionally placed because the Zünd cutter is selected. 

4. Select the Job Identification inspector and set Job Priority to "High". 
5. Submit the job and select “Make and hold” workflow and "Make and send to cutter" Cut Files. 
6. Context-click the job and select “Save As Template”. 
7. Save the template in any category with name “Anapurna Basic Job Parameters”.  
 
 

Sheet mark sets and other parameters 
1. Duplicate Basic Collecting Hot Ticket – Hold. 
2. Rename it to “Collecting Hot Ticket Basic Job Parameters”. 
3. Select the Collect Task Processor in the plan and select the “Anapurna Basic Job Parameters” Ticket 

template. 
4. Submit the Collecting Hot Ticket and enable the input to allow uploading of files. 
5. Upload the "Asanti Visual 390x250.pdf" and "pancakes.pdf" files. 
6. Flush the sheet of "Collecting Hot Ticket Basic Job Parameters". 
7. Open the Raster Preview of the rendered job "Anapurna Basic Job Parameters [TIME]". 

• The "Image Info" mark set will be missing: image marks sets need to added via Presets (see next exercise). 

• The "Zünd" and "Print Info" mark sets are included. 

8. Close the Raster Preview.  
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9. Check the Job priority of our job in the Joblist. 

• Priority of the job is High as we defined in the Ticket Template. 

 

 

• The Priority column might be not visible: context-click the Joblist 
purple header and select the Priority option 

• Any parameter that is defined in the Ticket Template will be used in 
the job created by the Collecting Hot Ticket (except for Sheet 
Alignment pins). 

 

Create new Ticket Template 
1. Edit the “For template creation only” job. 
2. Select the "pancakes" file in the Products list or on the sheet. 
3. Open the Presets, create a new preset and name it "image info". 
4. Select the "Image Mark Sets" option. 

• Behind the Image Mark Sets option you should see the following text in light grey 
"1 mark set(s)". 

5. Lock the "image info" Preset by clicking the padlock. 
6. Context-click the "image info" Preset and select "Apply to New Images". 

• The Preset icon should become green. 

7. Close the Presets dialog. 
8. Submit the job and select “Make and hold” workflow and "Make and send to cutter" 

Cut Files. 
9. Context-click the job and select “Save As Template”. 
10. Save the template in any category with name “Anapurna Advanced Job Parameters”. 

  



Tutorial Workflow Automation Collecting Hot Tickets 

 

 
   Page | 14  

 

Image mark sets in jobs made by Collecting Hot Tickets 
1. Duplicate the “Collecting Hot Ticket Basic Job Parameters”. 
2. Rename it to “Collecting Hot Ticket Advanced Job 

Parameters” 
3. Select the Collect Task Processor in the plan and select the 

“Anapurna Advanced Job Parameters” Ticket template. 
4. Submit the Collecting Hot Ticket and enable the input to 

allow uploading of files. 
5. Upload the "Asanti Visual 390x250.pdf" and "pancakes.pdf" 

files. 
6. Flush the sheet of "Collecting Hot Ticket Advanced Job 

Parameters". 
7. Open the Raster Preview of the rendered job "Anapurna 

Advanced Job Parameters [TIME]". 

• The "Image Info" mark set should now be included. 

8. Close the Raster Preview.  
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5. Collecting Hot Ticket Layout algorithm 

Files are rotated if possible (when Collect option is enabled) 
1. Select the Basic Collecting Hot Ticket – Hold. 
2. Make sure that there are no files in the Collecting Hot Ticket queue, 

delete any files in the queue if present. 
3. Upload the “ASANTI Visual 390x250.pdf” file. 
4. Flush the sheet to see how this file is placed on the sheet. 

• The file is rotated 90 degrees counter clockwise. 

• This is due to the “Rotate” setting in the Collect Task Processor. 

• When this option is enabled then landscape files will always be 
rotated (if they fit on the sheet in rotated orientation). 

Tallest files are placed first 
1. Upload again the “ASANTI Visual 390x250.pdf” file to Basic Collecting Hot Ticket – Hold. 
2. Upload also the “Asanti CMS demo page V5.pdf” file. 
3. Flush the Collecting Hot Ticket sheet again to have a look at the created layout. 

• Notice that the “Asanti Visual 390x250” file is not placed in the first location even though it was 
uploaded first. 

• The Collecting Hot Ticket layout algorithm will always put the "tallest" file first on the sheet 
regardless when this file was uploaded. 

• Due to this layout algorithm it is possible that earlier smaller uploaded files are ending 
up on a second sheet (or third sheet or fourth …). 

4. Upload again the “ASANTI Visual 390x250.pdf” file to Basic Collecting Hot Ticket – Hold. 
5. Upload also the “Asanti CMS demo page V5.pdf” file. 
6. Finally add the files “Agfa Flag.pdf”, “Circle of Asanti.pdf” and “Do Not Disturb (CMYK).pdf”. 
7. Flush the sheet and look at the created layout.  

• Again you will see that the order of file input is not important for the placement: the 
“Agfa Flag.pdf” file was uploaded as last and yet is placed in the second position 
(because it is the second tallest file in the list). 
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When base row is full, files are placed in a higher row 
8. Upload again the files “Agfa Flag.pdf”, “Asanti CMS demo page V5.pdf”, “ASANTI Visual 390x250.pdf”, “Asanti-sticker-01.pdf”, “Circle 

of Asanti.pdf”, “Cleaning Product CMYKWhite.pdf” and “Do Not Disturb (CMYK).pdf” to the Basic Collecting Hot Ticket - Hold. 
9. Flush the sheet to have a look at the created layout. 

• The “Asanti-sticker-01.pdf” is taller than “Cleaning 
product CMYKWhite.pdf” if it would be rotated. 
However, the available sheet size is insufficient to 
place this file in rotated mode therefore the 
“Cleaning Product CMYKWhite.pdf” is placed in right 
top. 

• Therefore, the “Asanti-sticker-01.pdf” file is not 
rotated and placed in a free spot in a lower row. 

 

 

Add more files to fill the sheet more 
10. Upload the files “Agfa Flag.pdf”, "Agfa_logo_color.jpg", “Asanti CMS demo page V5.pdf”, 

“ASANTI Visual 390x250.pdf”, “Asanti-sticker-01.pdf”, "Castle-4-EPS.jpg", "CHIMAY 
BLEU.jpg", "CHIMAY.jpg", “Circle of Asanti.pdf”, “Cleaning Product CMYKWhite.pdf”, “Do 
Not Disturb (CMYK).pdf”, "Fish_Label_Layers.pdf", "Flowers 150x50mm.pdf", 
"Huidtinten.jpg", "Leaves or circles.pdf" and "Leeuw-4-USM.jpg". 

• The sheet will be flushed automatically since the 80% threshold is reached.  

• Notice that the Lion file has caused the “Cleaning Product CMYKWhite.pdf” file to be 
moved because the Lion file is just a bit taller. 
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6. Collecting Hot Ticket Options 

Rotating Images 
1. Duplicate Basic Collecting Hot Ticket – Hold. 
2. Name the new CHT “Basic Collecting Hot Ticket – Hold no rotate”. 
3. Select the Collect Task Processor in the plan and deselect the 

rotate option.  
4. Submit the Collecting Hot Ticket and enable the input to allow 

uploading of files. 
5. Upload the same files as in previous exercise: “Agfa Flag.pdf”, 

"Agfa_logo_color.jpg", “Asanti CMS demo page V5.pdf”, “ASANTI 
Visual 390x250.pdf”, “Asanti-sticker-01.pdf”, "Castle-4-EPS.jpg", 
"CHIMAY BLEU.jpg", "CHIMAY.jpg", “Circle of Asanti.pdf”, 
“Cleaning Product CMYKWhite.pdf”, “Do Not Disturb (CMYK).pdf”, 
"Fish_Label_Layers.pdf", "Flowers 150x50mm.pdf", 
"Huidtinten.jpg", "Leaves or circles.pdf" and "Leeuw-4-USM.jpg". 

• Notice that for this Collecting Hot Ticket a second sheet is 
created with some of the smaller images. 

6. Manually flush sheet 1 and have a look at the layout result. 

 

 

• The layout algorithm has again placed the tallest file first however this time the files 
are not rotated so the tallest page is now “Agfa Flag” and not “Asanti CMS demo page 
V5”. 

• Also for the other files the height was used to determine the placement order. 

• Compare this result with the result from the previous exercise were rotation was 
enabled.  
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7. Upload now the “Woman with grapefruit 493x740.jpg” to “Basic 
Collecting Hot Ticket – Hold no rotate”. 

• The file will not be placed on the sheet: the “On” column stays 
empty and the file is also in error. 

8. Clicking the error icon. 

• The error mentions that the file is too large to fit on the 
Collecting Hot Ticket sheet. 

 

 

 

9. Context-click the file to delete it. 

Create new Ticket Template 
1. Edit the “For template creation only” job and change the sheet size 

to 1510x850 mm. 
2. Adjust the Finishing Margins by clicking on the grey circle with 

white arrow. 
3. Set space between the images to 15 mm to provide sufficient 

space for the image info mark set. 
4. Submit the job. 
5. Context-click the job and select "Save As Template". 
6. Save the Template in any category and name it "Anapurna 

1510x850 production quality hold". 
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Grouping Images 
1. Duplicate the “CopyCount Collecting Hot Ticket – Hold”. 
2. Name the new Collecting Hot Ticket “Group by Document”. 
3. Select the Collect Task Processor in the plan and select the "Anapurna 

1510x850 production quality hold" template. 
4. Enable also the “Group images by property” option and select 

$DOCUMENTFILENAME. 
5. Optionally adjust also the Flow Identifier to "Anapurna 1510x850". 
6. Submit the Collecting Hot Ticket and enable the input to allow uploading of 

files. 
7. Upload the file “Text boards 4 pages.pdf”. 

• This is a multi-page document of 4 pages. 

• Each page will represent 1 file in the Collecting Hot Ticket queue. 

• All these files should be kept together on the layout as specified by the grouping settings of the Collect Task Processor. 

8. Additionally, upload these files: “ASANTI Visual 390x250.pdf” and "Castle-4-EPS.jpg". 
9. Upload the " Castle-4-EPS.jpg " a second time. 
10. Finally add also the “CHIMAY_3.pdf” file from the CopyCount folder we created earlier. 
11. Flush the sheet and have a look at the created job result. 

• All pages from the "Text boards 4 pages.pdf" file are more or less kept 
together (due to the grouping on $DOCUMENTFILENAME). 

• The two instances of the "Castle-4-EPS.jpg" are also kept together (also 
due to the grouping on $DOCUMENTFILENAME). 

• Files with a copycount (# > 1) are always grouped together even when 
grouping is not enabled.  
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12. Edit the Collecting Hot Ticket “Group by Document” and disable the grouping, submit the changes. 
13. Upload the same files again as before: “ASANTI Visual 390x250.pdf”, " Castle-4-EPS.jpg" (x2) and “Text boards 4 pages.pdf”. 
14. Add the “CHIMAY_3.pdf” file from the CopyCount folder at the end. 
15. Flush the sheet and have a look at the job result. 

• The pages from the "Text boards 4 pages.pdf" file are scattered across the 
sheet. 

• The 3 Chimay logo's are grouped together (files with # copycount are always 
grouped). 

• The castle file which is the shortest file is placed last. The two instances are 
placed next to each other because the instances have (obviously) the same file 
dimensions.  

• The order of uploading the files to a Collecting Hot Ticket with grouping 
enabled might influence the files placement on the sheet (in contrast to 
Collecting Hot tickets without grouping). This is not demonstrated nor explained further in this Tutorial. It is designed like this by the 
layout algorithm that is currently being used. 

 
 

Using the Collect timeouts 
1. Duplicate Basic Collecting Hot Ticket – Hold. 
2. Name the new Collecting Hot Ticket “Notify and AutoFlush”. 
3. Select the Collect Task Processor in the plan and adjust the “Notify after” option 

to 1 minute. 
4. Adjust also the “Submit after” option to 3 minutes.  
5. Submit the Collecting Hot Ticket and enable the input to allow uploading of files. 
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6. Upload the files: “Agfa Flag.pdf”, Agfa_logo_color.jpg”, “Asanti CMS demo page V5.pdf”, “ASANTI Visual 390x250.pdf”, “Asanti-sticker-
01.pdf”, “Castle-4-EPS.jpg”, “CHIMAY BLEU.jpg”, “CHIMAY.jpg”, “Circle of Asanti.pdf”, “Cleaning Product CMYKWhite.pdf”, “Do Not 
Disturb (CMYK).pdf”, "Fish_Label_Layers.pdf" and 
"Leaves or circles.pdf". 

• The Collecting Hot Ticket status bar will turn orange 
because the 60% threshold has been reached in 
addition a timer is started. 

• If there are no more files added to the Collecting Hot 
Ticket for 1 minute, then a message is sent (see 
warning icon). This is caused by the Notify option in 
the collect settings. 

• You can also see a dark grey status bar below the 
orange status bar (click on a file in the queue to 
update the grey status): this bar represents the time 
that has passed since adding the last file. 

• When the grey status bar reached its complete length then the Collect setting “Submit after” timeout of 3 minutes has been reached 
and will flush the sheet automatically. 
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7. Collecting Hot Tickets for Roll Media 

Create new Ticket Template 
1. Edit the “For template creation only” job and change media to “Print on roll” and set width to 1400 mm. 
2. Select the Finishing Inspector and set the Finishing Margins back to "iCut 

Corner Marks, between 10". 
3. Open the Presets dialog, context-click the image info Preset and select "Don't 

Apply to New Images". 
4. Submit the job and select “Make and hold” workflow. 
5. Context-click the job and select “Save As Template”. 
6. Save the template in any category with name “Anapurna 1400 Roll”. 

 
 

Create and use CHT for Roll media 
7. Duplicate "Basic Collecting Hot Ticket" and rename it to “Roll Collecting Hot 

Ticket”. 
8. Select the Collect Task Processor in the Plan and change the Ticket Template 

to “Anapurna 1400 Roll”. 
9. Optionally change the Flow identifier to "Anapurna 1400 Roll". 
10. Change also the “Maximum length” to 10 meter and the “minimum length” to 5 

meter. 

• The created job from this Collecting Hot Ticket will be a Roll job between 5 
and 10 meter. 

11. Submit the Collecting Hot Ticket and enable the input. 
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12. Upload the first 7 files from the Asanti SampleFiles: “Agfa Flag.pdf”, “Agfa_logo_color.eps”, “Agfa_logo_color.jpg”, “Asanti Box.pdf”, 
“Asanti Box_Pantones.pdf”, “Asanti CMS demo page V5.pdf” and “ASANTI Visual 390x250.pdf”. 

• The Collecting Hot Ticket status bar is initially different for Roll jobs as for Sheet jobs. 

• The initial bar only shows one threshold representing the minimum length (5 meter). 

• The length of the currently placed files only represent 512 mm (approx. 0.5 meter). 

• The current length is too small to start checking if sufficient coverage is achieved. 

 
13. Upload these files: "pancakes.pdf", "Text boards 4 pages.pdf", "Text boards.pdf" and "Woman with grapefruit 493x740.jpg". 

• The minimum threshold of 5 meter is still not reached therefore the initial 
Roll status bar is still shown. 

14. Add now the "Asanti Visual 1200x797.jpg" file. 

• The minimum threshold of 5 meter is reached so the Collecting Hot Ticket status bar 
now changes to the regular status bar. 

• The coverage of the roll will now be calculated: if it exceeds 80% then the roll will be 
auto-flushed (which is the case in our scenario). 

15. Edit the created job (Anapurna 1400 Roll [TIME]). 

• The Layout editor indicates a waste of 12% which means that the coverage of the 
current Roll is 88% (so it exceeds the 80% threshold as defined in the Collect settings 
and therefore the job was auto-flushed). 

16. Submit the job and click Discard. 
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8. Advanced Collecting Hot Tickets 

Apogee Preflight Collecting Hot Ticket 
1. Duplicate the "Basic Collecting Hot Ticket - Hold", rename it to “Apogee Preflight Collecting Hot 

Ticket”. 
2. Select the Plan tab and then select the Process tab to drag the Apogee Preflight Task Processor 

between the Normalize and Collect Task Processor (release the mouse when a green vertical line is 
shown). 
 

 
3. Select the Apogee Preflight Task Processor in the plan and 

click the padlock to unlock the settings. 
4. Type "check image" in the Action List filter. 
5. Enable the "ap_Check image resolution" action list and click 

the arrow at the end of the action list to customize its 
settings. 

6. Select "Post warning" for images with a resolution below 149 
DPI and click OK. 
 
 
 

7. Remove the "check image" filter and type "fail jpeg". 
8. Select the "ap_Fail If JPEG HighCompressionRatio" action List. 

 
 
 

9. Remove the "fail jpeg" filter. 
10. Select the "On" category in the State pane. 
11. Deselect the "Hairline" action. 
12. Submit the Collecting Hot Ticket and enable the input.  
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13. Upload the following files “Agfa Flag.pdf”, “Asanti Box.pdf”, “Asanti CMS demo page V5.pdf”, “Asanti-sticker-01.pdf” and “Circle of 
Asanti.pdf”. 

14. The “Asanti Box” file will generate a warning, informing 
you that the resolution is relatively high. 

• Files with higher resolutions might require a longer 
render time. 

15. You can acknowledge this warning but you don’t have to (file is placed on the 
Collecting Hot Ticket sheet anyway). 

16. The “Asanti CMS demo page V5.pdf” file will generate an error because some 
images in the file are using a high JPEG compression ratio. 

• Note that files with errors are not placed on the Collecting Hot Ticket sheet 
(the "On" column is not filled out). 

17. You can click "Yes" to continue processing the file (ignoring the error). 

• The error will be removed from the file and the file will now be placed on the 
Collecting Hot Ticket sheet. 

18. You could also decide to click "No". 

• The error stays active and the file is not placed on the Collecting Hot Ticket 
sheet. 
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CAUTION: The next exercise requires the optional Automate Task Processor. 

Creating new Ticket Templates 
1. Edit the “For template creation only” job. 
2. Remove the pancakes file from the sheet. 
3. Change media to “PVC Banner” (or any other media) with sheet size 1500x650. 
4. Submit the job and select “Make and hold” workflow. 
5. Context-click the job and select “Save As Template”. 
6. Save the template in any category with name “Anapurna 1500x650 PVC Banner”. 
7. Edit the “For template creation only” job again and select a different device (we will use the Anapurna M2050). 
8. Change also the media to “Self Adhesive Vinyl” (or any other media) with sheet size 700x950. 
9. Submit the job and select “Make and hold” workflow. 
10. Context-click the job and select “Save As Template”. 
11. Save the template in any category with name “M2050 700x950 Self Adhesive”. 

Automate Collecting Hot Ticket 
1. Duplicate the "Basic Collecting Hot Ticket - Hold", rename it to “Automate Collecting Hot 

Ticket”. 
 

2. Select the Plan tab. 
3. Select the Process tab and drag the Automate Task Processor between the Normalize and 

Collect Task Processor, release the mouse when you see a green vertical line. 
 
 
 

4. Select the Output tab and drag the Collect Task Processor to the Plan below the first Collect 
Task Processor. 
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5. Connect the Automate Task Processor in the plan with the second Collect Task Processor by clicking the Automate 
“end connector” point and drag it to the “start connector” point of the Collect Task Processor. You can release the 
cursor when the connection line becomes green. 

 
 
 

6. Change the Ticket Template of the first Collect to “Anapurna 1500x650 PVC Banner”. 
7. Change the first flow name to “PVC Banner”.  
8. Select the second Collect Task Processor and click the padlock to unlock the settings. 
9. Change the Ticket Template of the second Collect to “M2050 700x950 Self 

Adhesive”. 
10. Change the second flow name to “Self Adhesive”. 

 

 

 

11. Select the Automate TP and click the padlock (1). 
12. Click the “+” button below the Cases pane (2). 
13. Select “When some criteria are met” as test condition 

(3). 
14. Click the “+“ button below the Case 1 settings (4). 
15. Type “filename” in the Variable field and select 

$document.filename from the list (5). 
16. Select “Contains” as Test and type as Value (a part of) 

the printer name of the printer that you used in the 
PVC Banner Ticket Template (we will use “H2050”) (6). 

17. Duplicate the complete test criteria with the “++” 
button (7). 

18. Change printer name (H2050) to “PVC” in the 
duplicated test criteria (8). 

19. Select as action “Send to output” (9) and select “1” 
(10). 
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20. Duplicate Case 1 with the “++” button below the Cases 
pane. 

21. Change in Case 2 the test criteria values “H2050” (your 
printer name) to “M2050” (the printer name used in the Self 
Adhesive Ticket Template) and “PVC” to “Adhesive”. 

22. Change the “Send to output” from “1” to “2”. 
23. Submit the Collecting Hot Ticket and enable the input. 

 
 
 
 
 

Adjust filenames with media or printer name 
1. Open Windows Explorer and browse to your Asanti SampleFiles. 
2. Create a subfolder in the Asanti SampleFiles directory and name this “Printer and media”. 
3. Copy 4 random Asanti SampleFiles to this folder. 
4. Add “PVC” to the filename of one of those files. 
5. Add “Adhesive” to another file. 
6. Add “M2050” (one of your printer names used in the Ticket 

templates for this CHT) to another file. 
7. Add “H2050” (the second printer name that you used in your 

Ticket Templates) to the last file.  

• It doesn’t matter where in the filename that you add the text: at the start, middle or at the end. 
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Upload the “printer and media” files to the CHT 
8. Drag all 4 files from the Printer and media to the Automate Collecting Hot Ticket 

• The files with the text H2050 or PVC will be send to the “PVC Banner” queue. 

• The files with the text M2050 or Adhesive will be send to the “Self Adhesive” queue. 

 
 

9. Upload the "Asanti Box.pdf" to the Collecting Hot Ticket. 

• The Collecting Hot Ticket will generate an error. The error 
indicates that the Automate "rules" have no specific setup for 
files that do not contain any of the words of our setup. 

10. Edit the Collecting Hot Ticket. 
11. Add a third Collect Task Processor to the plan and assign a Ticket 

Template to it (optionally adjust the Flow Identifier). 
12. Connect the third Collect Task Processor with the Automate Task 

Processor. 
13. Adjust the Automate settings: add a third case and select in the 

"Then" section to send the output to flow number 3. 
14. Submit the changes. 

 
 

15. Acknowledge the error message. 

• The "Asanti Box.pdf" will now get reprocessed and 
will be assigned to the third flow of our Collecting 
Hot Ticket. 
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